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Komodo CMS reduces technical complexity

Komodo CMS reduces design complexity

Komodo CMS gives you control over website access

Komodo CMS gives you the ease of simple and intuitive web editing

Komodo CMS has powerful and expandable features in a modular form

Komodo CMS is standards compliant, browser compatible and best of breed

Take a tour, examine the benefits and consider 
the potential return on investment.

a new breed
komodo cms
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KOMODO CMS COMMITMENTS

Komodo CMS aims to fulfil the internet’s promise of efficient and high
quality communication. It is built around a set of core commitments
to contemporary organisations ...

> World’s best

> Reliable, platform independent technology

> Intuitive, requiring minimal training

> Built to established standards and protocols

> Efficient, powerful, effective and a joy to use

> Secure, scalable, expandable and modular

> Enabling organisations to control their own content
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W E LC O M E TO A N E W WO R L D O F W E B M A N AG E M E N T

> Modify site content using your web browser

> Create new pages and alter structure*

> Manage and add new secure site sections*

> Manage site visitors, contributors and publishers and their privileges

> Automated uploading of documents, images, changes and other media

All this through your web browser, in a plain-language, intuitive 
and simple to use environment. Design consistency and 

compatibility issues are all handled for you, automatically!

* Level of functionality dependent upon Komodo CMS edition. 
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T R A N S FO R M YO U R O R GA N I S AT I O N ’ S
R E L AT I O N S H I P W I T H T H E W E B

Komodo CMS is about giving control back to organisations and empowering
staff and content contributors to make edits directly on your website.

> Website management roles are flexible to match your organisation’s structure

> User details, privileges and workflow are simple to establish and maintain

> Organisational branding is easily integrated and protected

> Changes can be immediately approved and uploaded to your site

> Modules and custom enhancements can be added to increase functionality

> Microsoft Internet Explorer or another browser is all you need to use
Komodo CMS
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T H R E E  PA R T S TO  YO U R W E B I N F R A S T R U CT U R E

Design
Use your current site design or talk to one of our 
Endorsed Design Partners about creating a new one.1

Functionality
Komodo CMS handles site access, site structure, 
editing, statistics, eCommerce, and most other functionality.2

Deployment
Have us host your site, host it yourself or use another 

Internet Service Provider.3

1 Komodo CMS can accommodate most site designs. Incorporation of design is included in the purchase
price subject to certain limitations. Endorsed Design Partners provide quotes for new designs.

2 Functionality is dependent upon installed Komodo CMS edition and extension modules. 
Edition pricing is contained on page 29.

3 Deployment and installation is free when hosting with us or one of our Hosting Partners.
Installation, deployment and technical assistance charges will apply for other hosting

arrangements. Hosting charges are available from our website.
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Benefits from reading this guide...

1 Understanding of Komodo CMS

2 Information to start using the system

3 Detail on product features

Reading this booklet from cover-to-cover
should take about 15 minutes.

At the end you will understand the key
benefits of Komodo CMS.

You will understand most of the basics of
how our web management system works 
and how it can work for you.

If you are using Komodo CMS for the first
time, this guide will give you a positive
experience and enable you to explore more
complex features at your leisure. 

user guide
komodocms

Web content management

We want your organisation to be able to
control and manage your own website(s) 
on your own terms.

What is content?

Text, images, multimedia, page design,
downloadable files, links and a range of
related items make up the content that 
Komodo CMS lets you control.

What tools do I need?

You need a computer. You need a web
browser. You need to be connected to the
server holding your site (usually over the
internet). You need to know what you want 
to achieve and what you want to say.

What are the benefits

You decide who edits your site
(Users and privileges)

You can create / edit / update content
(Site editing tools)

You select images and files for use
(Media management)

Site functions are handled for you
(Functional code is in-built)

Compatibility and standards
(Komodo CMS handles these for you)

Design integrity
(Your brand / design and styles are protected)

Modularity and scalability
(You can add modules and grow features)

ABOUT KOMODO CMSSTART HERE

GENESIS OF THE KOMODO CMS PRODUCT

The internet is a great channel for business and communication but organisations have found it
difficult to benefit efficiently from this environment. The aim of Komodo CMS is to allow in-house
control of web publishing functions, protection of corporate branding and processes, whilst allowing
flexibility and delegation of responsibility. Komodo CMS allows you to concentrate on your core
capabilities without having to become a web expert, a designer or a programmer. If you already 
have some of these skills, then Komodo CMS is a more efficient environment to get results.

Build your organisation a more powerful, flexible and impactful web presence. 09

welcome to
a new breed
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The highway >
Once Komodo CMS is installed on the web
server, your computer needs to be able to
access the site. Usually this simply means
you need internet access and a web browser.

A vehicle >
You need a website to edit and an
installation of Komodo CMS running it.

The keys >
You need a username and password.

A driver’s license >
Read this User Guide for the basics.

Anything missing?

If you are ready, skip the rest of this page and
turn to page 12. If any of these requirements
are missing, the following may help.

HIGHWAY – I need a connection

If you can currently browse the internet or
send an email, you are on the highway.

If not, you need a computer (any current type
will do), you need an internet connection
(some shopping around is recommended),
and you need a web browser (most likely
already installed on your computer).

Komodo CMS is tested for web browsers
such as Microsoft Internet Explorer,
Apple’s Safari, Mozilla Firefox and others –
for both visitors and editors. As a rule, 
try to keep your browser up-to-date.

In some cases, Komodo CMS may be
installed for internally accessible pages only
(for example, intranets). In this case, contact
your system administrator for access.

VEHICLE ... I need an installation

If you are setting up your organisation’s
website or wish to migrate to Komodo CMS,
contact us for an explanation or visit our
website – www.komodocms.com

In most cases, you will need ...

A domain name – the web address for your
organisation (e.g. www.myorg.com).

Web hosting – the physical machine and / 
or hard-disk space on which your site is
located, as well as the highway by which 
it is connected to the internet at large.

An installation – your website files, managed
by a Komodo CMS installation.

KEYS ... I need a password

As with many applications, you will require 
a username and password to prevent
unauthorised access and to identify your
editing rights and privileges.

LICENSE ... I need instructions

This guide will give you all the basics. 
The online help system within Komodo CMS
will provide additional guidance for the
features and modules installed. Additional
information can be obtained from your 
site administrator or by contacting Komodo
CMS directly.

REQUIREMENTS

11
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Logging in as an editor

1 Log in to your website by typing the website
address into a browser, followed by /login.
For example, www.myorg.com/login.

2 Enter your username and password to
enable you to access the site editor.

3 Click the login button.

4 You should now be logged in and notice
the green Komodo menu bar at the top 
of your web page window (fig. 1).

If you are new to Komodo CMS, we suggest
you familiarise yourself with the tools
described in this guide, practice some basic
editing and explore the editing interfaces.

Komodo menu bar

The Komodo menu bar provides access 
to most of Komodo CMS’s functionality,
including site and page management
functions, user management, file / media
management, publishing, installed extension
modules, content actions, online help,
preferences and the site view mode.

Site view mode
While logged in, you are able to toggle
between different site views using the 
Mode selector at the right-hand edge 
of the Komodo menu bar (fig. 2).

Edit provides all of the interface extras that
enable the user to add, delete, move, and
modify web page content.

Preview shows you how changes you have
made in Edit mode will be presented once
the upload procedure has been performed.
This mode looks and feels like the Live
mode, but has all of the content changes
that have been applied whilst in Edit mode.

Live shows the live website as visitors to the
site would see it, without recent edits that
are yet to be uploaded to the live site.

The concept of separation

One of the first rules of a good CMS, is that
the live website is separated from the one
being edited. Our terminology is live and
authoring. Other terminology you may have
encountered could include development
and deployment sites.

This guide is focussed primarily on guiding
you through the Edit mode. If you cannot
see something that is mentioned here, first
check that the site Mode is set to Edit.

MODESACCESS

Komodo CMS is a privilege-based system. The ability to upload edits to the live site and discard 
edits from the authoring site is a separate privilege to the ability to edit content, view a page or
perform other functions (see user privileges later in this guide).

The combination of authoring and live sites and various user privileges allows organisations to
customise individual responsibilities and create web management roles (such as content contributor,
content editor, and content publisher), as well as administrative functions for managing users, 
site preferences, site statistics and other features. 13

FIG.1

FIG.2
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On-screen editing tools

On a page with pre-existing content, the
following on-screen tools are provided to
assist with editing. For new pages without
content, see the Edit menu on page 15.

Paragraph selector

The check boxes on the page (fig. 3), allow
you to select one or multiple paragraphs
to the right of the check box. Once your
selection of items is made, you can select 
an action from the Edit menu (see page 15).

Paragraph editor

The arrow buttons on the page (fig. 3), allow
you to edit the paragraph settings for the
selected paragraph and override certain
item settings for all items contained within 
the paragraph.

Draft content

Certain content can be given a draft status
(see page 17). Draft content is not uploaded
to the live site until its status is changed.
Draft content is permanently highlighted 
in the Edit mode, in this case with a grey
background (fig. 3).

Item editor

As you pass your cursor over a text item, 
it will appear with a highlight colour behind
it, in this case a yellow highlight (fig. 3). 
By clicking on the text or any other editable
item, you will immediately jump to the Item
Editor window where you can edit the item
selected (see page 17).

Following links

As you pass your cursor over any item that
normally acts as a link, the red target symbol
will appear allowing you to activate the link.
While in Edit mode, clicking on an item will
open the Item Editor window. If you prefer to
follow a link, rather than edit the item, click
on the red target symbol instead (fig. 3).

You will find the Edit menu (fig. 4) in the
Komodo menu bar at the top of the page.

The Edit menu allows you to perform a
number of important editing functions.

For some of these functions, you first need
to select the item or items that you wish to
manipulate, using the paragraph selector
check boxes (fig. 3).

Once the items are selected, choose the
required action from the Edit menu (fig. 4).

Where the action requires a content selection
to complete the process (for example,
copying and pasting), move to the required
location, tick the paragraph selector check
box where you wish to paste the moved item
and then choose the paste option from the
Edit menu.

Edit menu options

Add a new item
Select all paragraphs
Deselect all paragraphs
Cut
Copy
Paste
Delete
Copy page
Cut page
Paste page
Delete page

EDIT MENU ACTIONSEDITING BASICS

MORE ABOUT DRAFT CONTENT AND TEXT HIGHLIGHTS

Content can be pre-prepared for events such as press releases, upcoming news, or for any other
reason. Such content can be given the status of Draft (see page 17). Draft content is indicated by
permanent highlighting when in the Edit mode. When an authorised user uploads content to the live site
(page 21), draft content is not uploaded. To upload draft content the draft status must first be removed.

Highlight colours for both draft content (shown here in grey) and for editable items (shown in yellow)
form part of the initial site installation (design) so as not to clash with other colours selected for the
site, such as the background colour. Grey and yellow are the default colours for sites with a white
background and black text colour. 15

FIG.3

FIG.4
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In addition to the Komodo menu bar (page 12)
and the on-screen editing tools (page 14),
Komodo CMS has a broad range of pop-up
editor windows that offer a wide array 
of functions.

The Komodo menu bar provides access to
a number of these editor windows, some
of which are discussed later. The most
commonly used of these is the Item Editor.

Item editor window

Clicking on an item in Edit mode will launch
the Item Editor window (fig. 5).

When a new item is created, either from the
Edit menu or from within the Item Editor
window, the initial screen will ask you to
select the item type (text, image, table,
multimedia, etc.) that you wish to create.

For an existing item, the Item Editor window
will appear, allowing you to edit the item.
The editing options displayed depend upon
the type of item being edited. For text items,
the editable options include text style, text
alignment, colour, size and the content itself.

The Item Editor window also allows you to
move between items, save changes and add
additional content items below the one you
are currently editing.

The item status option allows suitably
authorised users to save content as draft
(see page 15) or as protected content 
that is not editable by users with lesser
access privileges.

EDITOR WINDOWS

FIG.5
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CUT COPY PASTE

Komodo CMS makes editing content easy
through the use of familiar editing tools
such as cut, copy, paste.

Cut and copy

To cut or copy a paragraph on a page, simply
tick the checkbox to its left (fig. 3), then
select the cut or copy action from the Edit
menu (fig. 4) in the Komodo menu bar.

Cutting content will remove the content from
the page and store it in the Komodo CMS
clipboard so that it is ready to be pasted
elsewhere on the website.

Copying simply stores a copy of the selected
content in the clipboard so that it is ready
to paste.

Paste

To paste content, go to the destination page
and tick the paragraph checkbox where you
wish to paste the content. Then select paste
from the Edit menu (fig. 4) in the Komodo
menu bar. If the destination page does not
contain content, simply select paste from 
the Edit menu to place the clipboard content
at the top of the page.

Delete

To delete a paragraph on a page, simply tick
the checkbox to its left (fig. 3), then select
the delete action from the Edit menu (fig. 4)
in the Komodo menu bar.

Cut, copy, paste and delete whole pages

When using Komodo CMS Professional 
and Enterprise editions, it is also possible 
to cut, copy, paste, and delete pages within
the sitemap, thereby changing the website
structure (see page 25).
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FIG.7

More editing power

Editor windows have a large number of
editing options to provide flexibility and
functionality. The tabs along the top of 
the editor windows group the available
editing options.

The link tab

To turn a piece of text or an image into a
link, select the link tab in the Item Editor
window (fig. 6). You can choose the type of
link (web, internal, email or download),
provide the details of the link destination
(such as the page of your site or any
external web address) and whether you
would like the target page to launch in 
a new window or use the current one.

The best way to explore the functionality is 
to try a few link types and test the results.

LINKS AND TABS

Also located in the Item Editor window, you will find a log tab. This section provides a chronology of
actions that have occurred for this particular item, including the nature of the action, the time and
date that it occurred and the user who performed the action.

When creating an internal link, Komodo CMS will provide you with a list of pages in your site to which
you can link. In addition, you can also select an item on the selected page. This is particularly useful
for very long pages (for example, intranet pages) where you wish the user’s browser to open the page
at the exact location of a particular item on the page. In order to use this feature, you need to give
the ‘destination content item’ an item name. You can find the item name field in the link tab of the
Item Editor window. 19

FIG.6

MEDIA MANAGER AND IMAGE RESIZING

Komodo CMS has a Media Manager facility
to assist you in the storage, location and
manipulation of various files used in 
the website.

Media Manager defines three key categories
for different types of website resources;
images, multimedia and downloads.

The image manager stores all images used
in the website. The multimedia manager
holds QuickTime and Windows Media Player
files as well as Macromedia Flash files. 
The downloads manager holds files that
people will download from your site such 
as PDF documents.

To open the Media Manager, simply select
images, multimedia, or downloads from the
File menu in the Komodo menu bar.

The left hand panel of the Media Manager
displays the directory structure for the
selected category. Directories are indicated
by bold dark green text, with files shown in
lighter green text (fig. 7).

You can preview a file or view its details by
simply clicking on its name. This will bring
up the file information on the right hand 
side of the page under the Info tab.

The Info tab shows basic file information such
as size and modification date. The Usage tab
lets you know where the file is being used on
your site and the Resize tab lets you resize
image files to the dimensions you require.

Resizing Images

To resize an image, go to the Images manager
by selecting Images from the File menu in the
Komodo menu bar. Select the image to resize
by clicking on its name. Select the Resize tab
on the right hand side of the screen (fig. 7).
Select a new width, height, and name for
your image in the fields provided. You can
also tick the constrain proportions checkbox
to ensure that the image does not distort
when resized. Click the OK button to create
a new resized version of the image with the
name and dimensions specified.
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Navigating around Komodo CMS is generally
the same as moving around the web, and
like the web, there is often more than one
way to get the same result.

Usual navigation

Probably the best way of moving around is
by following the usual navigation links within
your site (see page 14). Not only is this simple,
but it is also a good way of testing links that
you have created to ensure visitors to the
site can move around effectively.

Other navigation aids

Other methods of navigating are provided in
various locations. For example in the editor
windows there are navigation arrows to
help you move between one content item
and the next.

Dynamic site map

You will find the dynamic site map in the
Komodo pull-down of the Komodo menu bar.

Click on the target next to a page name 
to go to that page (fig.11). You can use the
site map to see the site structure and page
relationships. Dotted lines show how pages
are linked in hierarchical relationships. 
In addition, you can click on the page names
to edit the properties of a particular page.
Options for creating new pages are also
accessible from the site map (subject to
Komodo CMS edition and access privileges).

If you are not familiar with the concept 
of separation, please read page 13 first.

Komodo CMS operates two site versions, 
an authoring site and a live site (also detailed
on page 13). All editing activities modify 
the content of the authoring site only.

In order to publish site changes to the live
site, a user with the Upload / Discard
privilege needs to perform an upload.

Uploading overwrites the live site with the
content of the authoring site which contains
the changes made. Discarding overwrites
the content of the authoring site with the
content of the live site – in effect removing
all changes since the last upload.

The process of uploading

Only a person with publishing privileges can
upload content. This allows the separation
of editing and publishing privileges within
an organisation.

To upload or discard content, select the
required action from the Publish pull-down 
in the Komodo menu bar (fig. 8).

There is also an option to upload or discard
only a single page of content. From the
required page select the single page option
from the Publish menu.

PUBLISHINGNAVIGATING

Items that are in draft mode, highlighted by the draft background colour (fig. 3) are not carried 
across to the live site when an upload is carried out. This allows content to be left in a draft state
or prepared for future release (for example forthcoming products, news, press releases or other
content not ready for general release).

For most installations, the upload process for an entire site takes less than 5 seconds. 21

FIG.8
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FIG.9

Selecting any option under the user pull-down
in the Komodo menu bar will bring up the
User Editor window. This window has a
number of tab options for search, list,
details, privileges and logs.

Search

Allows you to search for any user within
the particular Komodo CMS installation.

List

Provides a full list of users within the
particular installation or the results of a
search (as described above). Within the list,
the person icon allows you to edit user details.
To edit user access privileges, select the
key icon. You can also create a new user
from this window.

Details

Contact details, username and password
details are all edited and maintained from
the detail tab of the User Editor window.

Privileges

Komodo CMS access privileges and edit rights
are maintained from within the privileges 
tab of the User Editor window (fig. 10).

Privileges include ...

View, edit content, edit advanced content, edit
protected content, page information, upload
and discard, new pages, new sections, assign
privileges, user details, site preferences,
site statistics and installed modules.

USERS AND PRIVILEGES

FIG.10

23

PUBLISHING REPORT

Komodo CMS provides publishing reports 
to inform publishers about who has made
changes to the website and the nature 
of those changes. This is of paramount
importance prior to uploading and discarding
website content.

When selecting an upload or discard action
from the Publish menu, the publishing report
screen is automatically opened for review.

The report tells the publisher who made the
last changes to each page, when the changes
where made and the nature of the changes.

To find out more detailed information on the
changes made to each page, simply click on
its name. Alternatively, if you wish to go to
the page to view its contents, click on the
target icon to the left of its name.

To upload Authoring changes to the Live site,
simply tick the checkboxes to the left of the
pages to be uploaded and click the Upload
Changes button at the bottom of the screen.
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Komodo CMS is an item based web content
management system and so far we have
covered most of the key item editing basics.

Subject to the Komodo CMS version that you 
are operating and your access privileges,
Komodo CMS also offers a number of page,
structural, administrative and advanced
editing features.

You can access the Page Editor window from
either the page properties option under the
Komodo pull-down of the Komodo menu bar,
or by clicking on a page’s name in the sitemap.

As with other editor windows, the Page
Editor is a tabulated interface, with options
for page details, metadata and logs.

Page details

The page detail tab indicates the section 
of the site where the current page resides.
From this tab, you can provide the name of
the page, the name that appears at the top
of the browser when the page is visited
(window title), whether you want the page
included in the site map or site searches, 
as well as other details relating to the
page status.

Page model

The Page Editor window also allows you
to choose a page model (basic site template)
from which you can construct the new page.
The page model provides the basic page
structure and navigational elements.

Pages can also be duplicated to enable 
rapid development of new pages complete
with content.

PAGES

User detail access, user management, page management, section management, and level of access
privileges all depend upon the installed Komodo CMS version and personally assigned access
privileges. If you believe you should have access to features discussed in this document and do not,
please contact your system administrator or Komodo CMS representative.

Detailed page editing training is provided for Professional and Enterprise installations and more
detailed instruction is contained in the online help section of your site. 25

SITEMAP

Komodo CMS provides a dynamic sitemap
that shows a hierarchical representation of
your website. To access the sitemap page
simply go to the website address followed
by /sitemap. For example
http://www.myorg.com/sitemap

The sitemap has two key functions. Firstly,
it acts as a navigation tool for both website
visitors and editors. Secondly, using cut,
copy, paste and delete page actions, editors
can move, duplicate and remove pages on
your website.

Sitemap page branches can be expanded
and contracted through the use of the +
and - buttons.

To create a new page simply tick the
checkbox to the left of a page that you wish
to use as a starting point. Select the copy
pages action from the Edit menu in the
Komodo menu bar. Now tick another
checkbox on the sitemap to tell Komodo CMS
where you want to paste the new page. Select
the paste pages action from the Edit menu
to complete the process. Komodo CMS will
then ask you if you want the new page placed
above, below or as a sub-page of the page
you selected. This determines its position
in the sitemap hierarchy.

FIG.11
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For larger organisations and web installations,
Komodo CMS offers industry leading section
management functionality.

A site can be broken into an unlimited number
of sections, each with their own unique user
privilege make-up, login requirements, and
defaults for everything from page model to
sectional metadata and access security.

Sections can be used for separating design
areas of the site, for creating protected
sections for members, staff (intranet),
customers or suppliers (extranets), specific
individual audiences or for any other reason.

Section editor window

For installations with section based editing
access, the Section Editor window is
accessed from the Komodo pull-down
in the Komodo menu bar.

Tabulated options in the window cover
section details, section security (login
requirements), section defaults, section
metadata and section logs.

More detailed section editing information
is provided in the online help system for
Komodo CMS versions where these features 
are installed.

Komodo CMS offers a number of other inbuilt
features beyond the scope of this document.

Some of these include ...

Table construction and management

HTML inclusions

Image editing

Deployment and rollout

Code inclusions and integration

Text style creation and editing

Text protection

Installable modules

Template / Page model building

Navigation menu editing

Spell checking

Search engine optimisation

Website statistics

Next steps

If you are interested in learning more,
examine the online help (accessed from
the Help section of the Komodo menu bar).

Also, contact your site administrator or your
Komodo CMS representative who can help
with training, additional documentation and
other guidance for advanced features.

ADVANCED FEATURESSECTIONS

Tables, media management, text styles and text protection are covered in standard Komodo CMS
training and are readily accessible from the online help system.

Code inclusions, system integration and certain other features require special license terms in
the form of an exception to the end user license agreement (EULA) or in the form of a Product
Development Agreement (PDA) or Endorsed Design Partner (EDP) Agreement.

Installable modules include but are not limited to, template builder, form builder, feedback module,
chat rooms, bulletin boards, list server, eCommerce, payment gateway, microsite builder, news
server, and XML data feeds. Custom expansion services are also available. 27
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KOMODO CMS FEATURE MATRIX
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Training hours, installation timing and
version pricing for the main subscription
levels of Komodo CMS.

Features*

Maximum number of authorised users
Number of provided page models
Maximum number of pages
Additional secure areas
Training provided (hours)
Average deployment timelines (weeks)

* Limitations are for normal installation and can be 
adjusted for payment of a scheduled amendment fee.

Training for the Enterprise Edition is in the form
of ‘train the trainer’ instruction.

Pricing*

US / World Version (US Dollars)
Australian Version (Australian Dollars)

* Pricing is valid at the time of publication
and is subject to change without notice.

Pricing does not include new site designs or
website hosting or specialised deployment
support (see page 6).

Publication date: May 2005

5 100 unlimited
2 5 20

50 2 000 unlimited
0 2 unlimited
2 4 15
1 2 12

$3 000 $7 000 $55 000
$4 000 $9 000 $70 000

KOMODO CMS VERSION DETAILS
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This product matrix provides an overview
of the features contained in the main
subscription levels of Komodo CMS.

Features

Plain language WYSIWYG text editor
Media manager (images/downloads/files)
Create/edit/move/delete content items
Separated editing (live and authoring modes)
User access and privilege management
Advanced table editing
Dynamic site search
Dynamic site map
Metadata and accessibility management
Browser and W3C standards compatibility
Site action logs and edit history
Site statistics and traffic reports
Spell checking
Image resizing
Publishing reports
Breadcrumbs navigation
Online help
Create/edit/move/delete site pages
Edit site navigation (drop-down menus)
Secure area (i.e. intranet) management
Lockable/protected (two-tier) content
Group based user access management
Create unlimited secure areas
Advanced workflow management
Authoring version control
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Important – Read Carefully
1.1 This End User License Agreement (EULA) is a legal

agreement between you and Komodo CMS Pty Ltd 
for the Komodo Content Management System (CMS)
product, connected technologies and services.

1.2 BY USING THE KOMODO CMS PRODUCT YOU AGREE
TO BE BOUND BY THE TERMS OF THIS EULA. IF YOU 
DO NOT AGREE TO THE TERMS OF THIS EULA, 
YOU ARE NOT PERMITTED BY LAW TO USE THE
KOMODO CMS PRODUCT OR RELATED SERVICES.

Definitions
2.1 In this agreement you means the entity that has

entered into this agreement and its affiliates and
agents, and we or us means Komodo CMS Pty Ltd
and its affiliates and agents. In addition, the
following definitions apply:

2.2 Affiliate means (i) with regard to you, any legal entity
that you own, which owns you, or which is under
common ownership with you, and (ii) with regards
to us, any legal entity that we own, which owns us,
or which is under common ownership with us;

2.3 Agent means a person or legal entity authorised
by the party to enter into an agreement, negotiate,
or transact on their behalf;

2.4 Anonymous user or visitor is a user who has public
or generally available access to the web pages
produced by the product and is not required to
provide a username or password and who does
not have access to the content management or
administrative functions of the product. For the
purpose of this EULA, an anonymous user is not
considered to be a user of the product and is not 
a party to this agreement;

2.5 Authenticated user or product user is a user of 
the product who accesses the content management
or administrative functions of the product using a
password and username. The number of such 
users is limited by the product subscription level 
and detailed in the Certificate of Entitlement (CoE);

2.6 Komodo CMS means, depending upon context, (i) ‘us’,
(ii) the ‘product’ and related ‘service deliverables’, or
(iii) the brand, trademark and other intellectual
property owned by us;

2.7 Installation means depending upon context, (i) a
deployed version of the product, or (ii) the process,
settings and act of installing and deploying the
product, or (iii) a specific installation of the product;

2.8 Modules are additional components purchased to 
add functionality to the product. Purchased additions
are detailed in the Certificate of Entitlement (CoE);

2.9 Ownership means, for the purposes of the definition
of ‘affiliate’ above, more than 50 per cent ownership
or effective control;

2.10 Product means the Komodo Content Management
System, all related components, modules, custom
enhancements, documentation, marketing materials,
license agreements and other branded or identified
component parts;

2.11 Product details are specifics relating to the product,
outlining the product and delimiting the agreement 
or product subscription level;

2.12 Product development agreement or PDA is an
agreement provided by us to partner organisations 
or licensed organisations to allow either (i) resale of
the product, (ii) code access for limited development
purposes, or (iii) specific code access to third-parties
for product integration or custom enhancement. 
A PDA must be in writing and signed by us;

2.13 Service deliverables or services are additional or
included components, services and materials which
may form part of a Komodo CMS installation. These
may include custom development, training, support,
hosting, upgrades, documentation, design services
and other consultancy;

2.14 Software, depending on context, means (i) the
Komodo CMS product, (ii) the source code of the
Komodo CMS product, (iii) the Komodo CMS product 
as installed for a particular installation, (iv) other
third-party software, or (v) other software required
for the proper operation of the Komodo CMS product
(see Specified Operating Environment);

2.15 Subscription level is the variant of the product,
generally defined as either standard, professional,
enterprise or custom. The product subscription level
determines the product pricing and feature set, as
well as certain product limits and salient parts of the
user documentation. The Certificate of Entitlement
(CoE) details the licensed subscription level;

2.16 Unbranded installation is a licensed installation
of the Komodo CMS product that does not contain 
the ‘Powered by Komodo CMS’ icon/link on the home
page or primary page of the site. Such installations
are provided by special exemption and the payment of
the ‘Komodo CMS brand removal fee’ relevant to the
product subscription level;

2.17 Use means to copy, install, use, access, display,
run or otherwise interact with Komodo CMS;

2.18 User documentation is the instructional and
informational documentation, either electronic or
physical copy, that is provided with the Komodo CMS
product and applies to the specific installation.

Use and Ownership – Grant of License
3.1 The Komodo CMS software is owned by us and is

copyrighted and licensed, not sold.

3.2 Komodo CMS grants you a non-exclusive perpetual
license to the product as described in the Certificate
of Entitlement and detailed in this agreement,
provided that you comply with the terms of this EULA.

3.3 We do not transfer any ownership rights in the
product and reserve all rights not expressly granted.

Restrictions on Use
4.1 You are licensed to use the software up to the level

of use specified in the Certificate of Entitlement.

4.2 You may not:

(i) Reverse engineer, de-compile, alter or disassemble
the product or service deliverables, except to the
extent expressly permitted by applicable law, or
where expressly permitted under a Product
Development Agreement (PDA);

(ii) Transfer, sub-license, sell, rent, lease, lend,
duplicate, or otherwise translate the product or
service deliverables without express written consent
from us, detailing the nature of the exception or
where expressly permitted under a PDA;

(iii) Provide commercial hosting services utilising the
product or services delivered, including charging 
any user for product access, unless expressly
granted in writing by us;

(iv) Remove or obscure any copyright, trademark, 
patent or notices that appear on the product;
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4.3 You are required to:

(i) Operate the delivered software under the terms
of this agreement and in a manner consistent with
the operational instructions contained in the user
documentation relevant to your licensed installation
and product subscription level;

(ii) Ensure that any authenticated user who uses the
product does so only in compliance with the terms 
of this agreement;

(iii) Comply with all applicable international and national
laws that apply to this class of product;

(iv) The product may include code that operates in a
disabling or limiting function to enforce the terms 
of this agreement, prevent software piracy, prevent
unauthorised use, or to enforce subscription level
limits as detailed in the Certificate of Entitlement. 
You are not permitted to tamper with such devices.

Subscription Level
5 The general terms and conditions of this agreement

shall apply to the offering regardless of your
subscription level (i.e. standard, professional,
enterprise or custom solution), unless specifically
exempted in the Certificate of Entitlement (CoE) or
under a Product Development Agreement (PDA).

Product Warranty
6.1 Komodo CMS warrants that each commercial version

of the product will perform substantially in accordance
with our user documentation for the specified version
and product subscription level. This warranty is valid
for a period of one year from the date of installation.
This warranty does not apply if the failure of the
product has resulted from accident, abuse,
misapplication, breach of this agreement or 
from the actions of a third-party.

If you notify us in writing within the warranty period
that the product does not meet this warranty, we will
at our option, either (i) repair or replace the product,
or (ii) return the price paid for the product. To the
maximum extent permitted by law, this is your
exclusive remedy for any failure of the product.

6.2 To the maximum extent permitted by law, free and
beta products are provided ‘as-is’ without warranty.

6.3 We warrant that all services provided by us will be
performed in a good workmanlike manner.

6.4 TO THE MAXIMUM EXTENT PERMITTED BY LAW, WE
DISCLAIM AND EXCLUDE ALL REPRESENTATIONS,
WARRANTIES AND CONDITIONS, WHETHER
EXPRESS, IMPLIED OR STATUTORY, OTHER THAN
THOSE IDENTIFIED EXPRESSLY IN THIS EULA,
INCLUDING BUT NOT LIMITED TO WARRANTIES,
QUALITY, MERCHANTABILITY, FITNESS FOR
PURPOSE, AND NON-INFRINGEMENT WITH
RESPECT TO THIRD-PARTIES.

Privacy
7 You agree to allow Komodo CMS to store and use your

contact information. This information will be used
in connection with our business relationship and for
uses consistent with Komodo CMS’s business activities,
including marketing of the Komodo CMS product.
A copy of Komodo CMS’s privacy statement is available
from the Komodo CMS website – www.komodocms.com

Product Identification
8.1 All product subscription levels include product

identification marks. These include comments in the
source code and a ‘Powered by Komodo CMS’ icon that
functions as a web link to the Komodo CMS home page
which is included on at least the primary page of the
website(s) you produce using the Komodo CMS product. 

These marks identify the ownership of the product
and provide a business source to Komodo CMS for
the further development of the product. You agree 
not to tamper with these identifying elements. In
addition, this agreement and the use of these marks
does not grant you any right, title or interest in the
trademarks of Komodo CMS or associated entities.

8.2 Under certain circumstances, we will agree to the
removal of the ‘Powered by Komodo CMS’ icon after
payment of the published ‘Komodo CMS brand removal
fee’ relevant to the product subscription level. Such
an exemption must be approved in writing or included
in the Certificate of Entitlement (CoE).

Intellectual Property
9.1 This agreement does not include the transfer of any

intellectual property between us and you.

9.2 We retain ownership, copyright, moral rights and other
intellectual property rights pertaining to all products
and services delivered under this agreement, including
all agreements, specifications, user documentation,
marketing materials, developed code, software and
commissioned content unless otherwise stated or
exempted in writing.

9.3 Ownership, copyright, moral rights and other
intellectual property rights pertaining to all content
entered into the product for storage, delivery,
manipulation or other purposes rests with the legal
owner of the content and is in no way altered by the
terms of this agreement or the Komodo CMS product.

9.4 We warrant that any intellectual property embodied 
in or used by us in the product or in the delivery of
services is either the sole property of Komodo CMS
Pty Ltd or that we are legally entitled to use such
intellectual property for the provision of the product
and services outlined in this agreement.

9.5 You warrant that you are the owner or otherwise
legally entitled to use content stored in or delivered
by our product or services. Furthermore, you indemnify
us against any action, claim, suit or demand for, or
liability to pay compensation or damages and costs or
expenses arising out of or in respect of any breach by
you or caused by you of any third party’s intellectual
property rights.

Limitation of Liability
10.1 To the maximum extent permitted by law, our liability

for direct damages will be limited to the amount you
have paid for the product. The limitation contained
in this paragraph will not apply with respect to:

(i) our obligations to defend third-party claims of
patent, copyright, trademark or intellectual
property infringement;

(ii) our liability for gross negligence or wilful misconduct,
to the extent caused by us and awarded by a court
of final adjudication;

(iii) our confidentiality obligations.

10.2 TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE
LAW, NEITHER PARTY WILL BE LIABLE FOR ANY
INDIRECT DAMAGES (INCLUDING, WITHOUT LIMITATION,
CONSEQUENTIAL, SPECIAL OR INCIDENTAL DAMAGES,
DAMAGES FOR LOSS OF PROFITS OR REVENUES,
BUSINESS INTERRUPTION, OR LOSS OF BUSINESS
INFORMATION) ARISING IN CONNECTION WITH ANY
AGREEMENT, PRODUCT, FIX OR SERVICE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR
IF SUCH POSSIBILITY WAS REASONABLY FORESEEABLE.
THIS EXCLUSION OF LIABILITY DOES NOT APPLY
TO EITHER PARTY’S LIABILITY TO THE OTHER FOR
VIOLATION OF ITS CONFIDENTIALITY OBLIGATION
OR OF THE OTHER PARTY’S INTELLECTUAL
PROPERTY RIGHTS. 33
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10.3 The limitations and exclusions of liability in this
agreement apply regardless of whether the liability 
is based on breach of contract, tort (including
negligence), strict liability, breach of warranty, 
or any other legal theory.

Termination
11 This agreement will remain in effect until terminated.

We provide a non-exclusive perpetual license to the
product as described in the Certificate of Entitlement
(CoE) subject to your compliance with this EULA. You
may terminate this agreement by giving at least 30
days notice in writing and ceasing to use the Komodo
CMS product. You must also delete all relevant
computer files and return any Komodo CMS materials.
The sole effect of terminating this agreement will be
to terminate the ability of either party to enter into
subsequent product or service agreements under 
the terms of this license agreement. All terms and
conditions of this agreement will continue in effect
unless and until explicitly expired under this EULA.

Charges
12.1 The amount payable for the software license is a 

one-time charge unless stipulated in the Certificate 
of Entitlement (CoE).

12.2 If you wish to increase the level of use, you should notify
Komodo CMS and pay any applicable charges. You
will be issued with a revised Certificate of Entitlement
(CoE) reflecting the product subscription level, revised
product limits, incorporated modules, custom
enhancements, product variant or other stipulations.

12.3 If any authority imposes a duty, tax, levy or fee
upon the software or services, then you agree
to pay the amount specified or supply us with
exemption documentation.

Specified Operating Environment
13.1 The software’s specifications and specified operating

environment information is summarised in the
Certificate of Entitlement (CoE).

13.2 It is a condition of use that the software is deployed
and used in conjunction with the specified operating
environment. Failure to meet this condition will
breach the warranty clause of this agreement.

Upgrades
14 To purchase or use a product identified as an

upgrade, you must be licensed to use the product
identified by Komodo CMS as eligible for the upgrade.
After upgrading, you may no longer use the product
that formed the basis for your upgrade eligibility.

Confidential Information
15.1 Confidential information means information identified

in writing as proprietary or confidential, it also
includes non-public information regarding either
party’s products, marketing, promotions, business
processes, financial data and negotiated terms 
of agreement. Confidential information does not
include information which; (i) the recipient developed
independently, (ii) the recipient knew before receiving
it under the relevant agreement, or (iii) information
which becomes public other than by a breach of an
obligation of confidentiality in this EULA.

15.2 Neither party will use the other’s confidential
information without the other’s written consent
except, (i) in the furtherance of this business
relationship, (ii) to obtain advice from legal or
financial consultants, or (iii) as required by law.

15.3 Both parties will take reasonable precautions to
safeguard each other’s confidential information, at
least equivalent to those used to safeguard their own
confidential information. In the event of discovery
of unauthorised disclosure of information, the
discovering party will notify the other and cooperate
in any reasonable way to regain possession of the
information and minimise potential loss.

15.4 Komodo CMS provides a number of support and
product feedback mechanisms to improve the quality
of the product. By using any such mechanism or
providing unsolicited ideas or suggestions, you agree
that all such content is not confidential and becomes
the sole property of Komodo CMS without compensation.

Notices
16 All notices, requests and communications pertaining

to this agreement must be sent by post, express
courier, or email to the normal business address of
the relevant party. Notices will be deemed delivered
on the date shown on the postal return receipt or on
the courier, or email confirmation of delivery.

Assignment
17 Neither party may assign the agreement in whole or

part without the written consent of the other.

Severability
18 If any provision of this agreement is held to be illegal,

invalid, or unenforcable, the remaining provisions will
remain in force and effect and the parties will amend
the agreement to give effect to the stricken clause to
the maximum extent possible.

Waiver
19 No waiver of any breach of this agreement shall be

a waiver of any other breach. No waiver shall be
effective unless made in writing by the waiving party.

Force Majeure
20 To the extent that either party’s performance is

prevented for reasons beyond that party’s control, then
that party will not be liable, so long as performance
is resumed as soon as practical after the cause no
longer exists.

Survival
21 Provisions regarding product use, restrictions on

use, warranty, limitation of liability, confidentiality,
intellectual property, and specified operating
environment will survive the termination of
this agreement.

Non-exclusivity
22 This agreement is non-exclusive.

Applicable Law
23 This agreement is entered into in the State of Victoria,

Australia, and you agree that all matters including
all disputes, shall be governed and construed in
accordance with the laws of the State of Victoria, and
waive any objection to such a jurisdiction or venue.

Execution
24.1 I have read and understand this EULA and I hereby

agree with, accept, and consent to, the terms and
conditions of this agreement.

24.2 I accept and understand that by purchasing or using
the product, I have indicated my acceptance of the
terms and conditions of this agreement. Where my
acceptance has been indicated electronically, I hereby
waive any claim or right that I may have to assert 
that my electronic acceptance is not the equivalent 
of, or deemed as, a valid signature to this agreement.
This agreement is executed by Komodo CMS Pty Ltd.
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113 Ferrars Street
Southbank 3006

Victoria Australia
T 613 9696 9597
F 613 9690 0092

www.komodocms.com
info@komodocms.com

© Komodo CMS Pty Ltd 2005

Komodo CMS Pty Ltd
ABN 35 080 392 865
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